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LLeeaarrnniinngg  OObbjjeeccttiivveess  
• 

• 
• 
• 

 
Understand the National Flood Frequency (NFF) software and its use in the National Flood 
Insurance Program (NFIP) 
Learn the functions of the NFF software 
Understand the NFF methodology 
Use the NFF software to estimate peak flow and flood hydrographs for selected frequencies
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Overview 
 
This tutorial will discuss the basic concepts of the National Flood Frequency (NFF) program and 
demonstrate how to use it.  The tutorial consists of three sections:  'Overview,' 'Program 
Navigation,' and 'Example.' 
 
Prior to running the NFF program for the first time, users should: 
 

Have a basic knowledge of hydrology principles • 
• 
• 

Be familiar with the National Flood Insurance Program (NFIP) 
Have a basic understanding of Microsoft Windows
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Introduction 
 
National Flood Frequency (NFF) is a widely accepted program developed by the U.S. Geological 
Survey (USGS) that is used to estimate peak flow (peak flood discharges) in ungaged locations.  
Values derived by the program often serve as input for other applications that are used to technically 
support end-products of the National Flood Insurance Program (NFIP).
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National Flood Frequency (NFF) Description 
 
NFF is: 

A widely used and accepted program for estimating peak flow and flood hydrographs for selected 
frequencies for ungaged locations; 

• 

• 

• 
• 

A collection of regression equations that calculate peak flood discharges from input variables 
based on climatic and physical characteristics of the watershed; 
Simple to use, it requires minimal computer resources;  
Used to estimate peak flood discharge for approximate Zone A areas.
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National Flood Frequency (NFF) Description (continued) 
 
NFF is: 

A strong tool for analyzing the sensitivity of results as a function of model input and assumptions; • 
• 
• 

• 

Equations are available in the program for all states and some U.S. territories; 
The program is endorsed by the U.S. Geological Survey (USGS), the Federal Emergency 
Management Agency (FEMA), the Federal Highway Administration, and most Federal agencies; 
and 
The program is often used to verify and/or substantiate flow estimation from rainfall-runoff 
modeling methods (HEC-1, TR-20, TR-55).
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Regression Equations 
 

The National Flood Frequency (NFF) software accompanies the U.S. Geological Survey (USGS) 
Water-Resources Investigations Report (02-4168), titled "The National Flood Frequency Program, 
Version 3:  A Computer Program for Estimating Magnitude and Frequency of Floods for Ungaged 
Sites,” Reis, K.G., III, and Crouse, M.Y., 2002.  This document is 42 pages. 

• 

• The regression equations were developed from data for gaging stations.  The statistical 
procedures used minimize the difference between the observed and estimated peak flow at these 
gage locations.

 
7



Regression Equations (continued) 
 

The regression equations estimate the peak flow associated with specific flood frequencies.  The 
National Flood Frequency (NFF) software computes 2-, 5-, 10-, 50-, 100-, 200-, and 500-year 
peak flow. 

• 

• 

• 

Regression equations are based on statistical relations between peak flow at gaging stations and 
watershed (physical) and climatic characteristics. 
Regression equations are developed for essentially homogenous hydrologic regions.
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Regression Equations (continued) 
 
Regression Equation Generalized Form: 
 
QT = aX1bX2c....Xnm  where, 
 

QT is the T-year peak flow based on the statistical analysis of observed peak flow using Bulletin 
17B guidelines.  

• 

• 

• 

• 

X1, X2,  ...Xn  are variables reflecting physical or climatic characteristics of the watershed, such 
as drainage area (DA), channel slope (SL), and mean annual precipitation (P). 
Other watershed characteristics, such as percentage of impervious cover, may be included in the 
regression equation as well. 
a, b, c, ... m are regression coefficients, estimated by statistical analysis.
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Regression Equations (continued) 
Regression equations: Strengths 
 

Simple to understand and apply for flood frequency analysis; • 
• 
• 
• 
• 

Generally reflect observed flood response to watershed characteristics; 
Relatively easy to estimate input parameters; 
Good for verifying alternative modeling results; and 
Based on sound statistical methods.
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Regression Equations (continued) 
Regression equations: Limitations 
 

Potentially large estimation errors (as high as 50% error or more) for some areas; • 
• 
• 

• 
• 

Generalized results that may not apply to the actual watershed or particular location; 
Cannot be used in watersheds with significant flood detention storage or other regulated flow 
conditions;  
Data set is often too limited for a strong statistical model; and 
Should only be applied to watersheds with characteristics within the range from which the 
equations were derived.
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Regression Equations (continued) 
Regression equations 
 
Estimates of error are based on the difference between the regression estimate of peak flow and the 
observed gaging station data used in deriving the equations. 
 

The greater the standard error, the greater the variability between observed peak flow and the 
estimates from the regression equations. 

• 

• Equivalent years of record indicates the number of years of gaged record that would be needed to 
determine the flood peak by frequency analysis with accuracy equivalent to that of the regression 
estimate.
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Regression Equations (continued) 
Urban Regression Equations: 
 
In general, National Flood Frequency (NFF) regression equations are applicable to rural, 
undeveloped watersheds.  U.S. Geological Survey (USGS) Water-Supply Paper 2207 has urban 
equations applicable to all states in the U.S.   
 
In addition to USGS Water-Supply Paper 2207, regression equations for urbanized watersheds have 
been developed for many states and metropolitan areas.

 
13



Regression Equations (continued) 
Urban Regression Equations (continued): 
 
Urban equations are similar to rural equations; however, they attempt to account for: 
 

Basin Development Factor (BDF) - an index of the prevalence of urban drainage improvements.  
BDF is a composite index of watershed channel improvements, channel linings, storm drains and 
sewers, and curb-and-gutter streets. 

• 

• Impervious Area (IA) - the percent of watershed occupied by impervious surfaces such as 
houses, buildings, streets, and parking lots.
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Input Variables 
 
Measurements for Input Variables include: 

Drainage area (square miles) • 
• 
• 
• 
• 
• 
• 
• 
• 
• 

Main channel slope (feet/mile) 
Mean annual precipitation (inches) 
Storage area of lakes and ponds (percent of drainage area) 
Rainfall amount per storm duration (inches) 
Elevation of watershed (feet) 
Forest cover (percent of drainage area) 
Channel length (miles) 
Minimum mean January temperature (degrees F) 
Basin shape (length2 divided by drainage area) 
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Input Variables (continued) 
 
Measurements for Input Variables include: 

Soils characteristics • 
• 
• 
• 
• 
• 
• 
• 
• 

Mean basin slope (feet/foot or feet/mile) 
Mean annual snowfall (inches) 
Area of stratified drift (percent) 
High elevation index (percent of watershed above 6,000 feet) 
Relative relief (feet/mile) 
Drainage frequency (number of 1st order streams per square mile) 
Area controlled by lakes, swamps, or storage ponds (percent) 
Area underlain by carbonate rocks (percent)
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Input Variables (continued) 
 
Input variables can be measured manually or using a GIS and appropriate data layers.  When a GIS 
is used, the data layers must be equivalent to the original maps used in the U.S. Geological Survey 
(USGS) studies to develop the regression equations.  The manual measurement method, 
demonstrated in the tutorial example, is often used for small watersheds.
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Input Variables (continued) 
Estimating Input Variables (examples): 
 
Drainage Area - Delineate the watershed boundary using topographic data [U.S. Geological Survey 
(USGS) quadrangle map].  Estimate the watershed area using an electronic planimeter or overlay the 
watershed with graph paper and count the number of grids that approximately cover the watershed.  
Derive the watershed area using the scale of the watershed map and the grid size.
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Input Variables (continued) 
Estimating Input Variables (examples continued): 
 
Main Channel Slope - Use a map wheel to measure the stream length in inches, and convert the 
value to miles using the map scale.  Estimate the vertical drop in the stream using the contour data.  
The representative channel slope should be estimated from a distance 10% upstream from the 
watershed outlet and 15% downstream from the furthest point on the basin divide that contributes 
water to the upstream end of the mapped stream. 
 
Mean Annual Precipitation - Provided in the National Flood Frequency (NFF) documentation for 
individual states.
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Input Variables (continued) 
Estimating Input Variables (examples continued): 
 
Storage of lakes and ponds - Estimate area from land cover or U.S. Geological Survey (USGS) 
quadrangle maps. 
 
Rainfall amount per duration - See National Flood Frequency (NFF) documentation for individual 
states or National Oceanic and Atmospheric Association (OAA) Atlas 2/National Weather Service 
(NWS) TP-40 precipitation publication. 
 
Elevation of watershed - Topographic map. 
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Input Variables (continued) 
Estimating Input Variables (examples continued): 
 
Forest cover – Land cover or U.S. Geological Survey (USGS) quadrangle map. 
 
Channel length – Topographic map. 
 
Minimum mean January temperature – See National Flood Frequency (NFF) documentation for 
individual states. 
 
Basin shape – Calculate from area and length after delineating the watershed boundary.
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Input Variables (continued) 
Estimating Input Variables (examples continued): 
 
Soils characteristics - Estimate from national or county soils maps published by the National 
Resources Conservation Service.  
 
Mean basin slope - Estimate from a small sample of representative points around the watershed, or 
use Geographic Information System (GIS)-based software. 
 
Geologic Parameters – Estimate the area of stratified drift/carbonate rocks using state geologic 
maps that show variable values. 
 
Mean annual snowfall - See National Flood Frequency (NFF) documentation for individual states or 
climatological reports.
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Overview Summary 
 
Congratulations, you have completed the Overview section of this tutorial.  Here is a review of the key 
points discussed in this section. 
 

National Flood Frequency (NFF) is a widely accepted program developed by the U.S. Geological 
Survey (USGS) that is used to estimate peak flow in ungaged basins. 

• 

• 

• 
• 

Regression equations are based on observed peak flood discharges data, statistical flood 
frequency analysis, and are regionalized at the state and sub-state level. 
An example form for a regression equation is QT = aAbScPd. 
The Regression Equation has several strengths and limitations. 
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Overview Summary 
 
Key points continued: 
 

Estimates of error are based on the difference between the regression estimate of peak flow and 
the observed station data used in deriving the equations. 

• 

• 

• 

Urban equations are similar to rural equations but attempt to account for Basin Development 
Factor (BDF) and Impervious Area (IA). 
There are several input parameters for National Flood Frequency (NFF) that need to be collected 
or estimated.
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Program Navigation 
 
Startup Window 
 
The startup window allows you to choose whether English or metric units will be used during this 
session.  A User name and Project name may also be entered.  These fields will be included in any 
reports generated during the session.
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Main Window 
 
The main window allows you to select a State, enter a user-defined Site Name, and choose between 
performing a Rural or Urban flood event estimate.  A change or deletion to the Site Name must be 
made manually and does not automatically change when the State is changed.  The window also 
allows you to edit data entered earlier.  An estimate is initiated by clicking the "New" button.
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Compute Window 
 
The compute window allows you to click on a region. A set of Variable fields appear that allow you to 
insert data into the regression equation.  The data must fall within a certain range or an error 
message will be generated.
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Compute Window (continued) 
 
If you want to compute the maximum flood envelope, you must also select the appropriate region 
from the Crippen & Bue flood region map.  After choosing a region number, close the map and pick 
the region from the pull-down menu. 
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Main Window (continued) 
 
When all data have been entered, click the "Ok" button.  When a rural or urban scenario has been 
computed, the parameters used in the computation are displayed in the top pane of the main window 
and the computed peak flows, available standard errors, and equivalent years of record are displayed 
in the bottom pane of the main window.
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Main Window (continued) 
 
You can now view a frequency or hydrograph plot of the data using the Graph menu or the buttons at 
the bottom of the main window.
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Main Window (continued) 
 
You can also Save and/or Print a Report, or open another file using the File menu.  A printed report 
includes the information displayed in the top and bottom panes of the window.
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Frequency Window 
 
When you click the "Frequency Plot" button, a Frequency window appears that allows you to choose 
more than one scenario.  This example shows only one scenario, Rural 1.  When you click the "Plot" 
button, you are presented with a Frequency Plot window displaying a graph of the Peak Discharge 
(peak flow) vs. Recurrence Interval.
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Frequency Window (continued) 
 
The Frequency Plot displays the peak discharge in cubic feet per second, for a given recurrence 
interval.  In this example, a 10-year recurrence interval has a peak flow estimated to be 13,000 
ft3/sec.  A 100-year recurrence interval has a peak flow estimated to be 24,000 ft3/sec.
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Frequency Window (continued) 
 
The Frequency Plot window contains File and Edit pull-down menus.  The File menu includes Print, 
Save, Open Specification, and Close functions. The Print function allows you to send the plot to a 
printer.  The Save function allows you to save the plot as a Windows bitmap (.bmp) file or as a 
Windows metafile (.grf) file.  The Open Specification function allows you to generate a Windows 
metafile (.grf) of the plot.  The Close function closes the Frequency Plot window.
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Frequency Window (continued) 
 
The Edit menu includes the Axes, Titles, Curves, Lines, General, Font, and Copy to Clipboard 
functions.
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Frequency Window (continued) 
 
When you click on any of the first five items in this menu, the Graph Edit window opens.
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Frequency Window (continued) 
 
When you click on the Font function in this menu, the Font window opens.  This window allows you to 
change the font type, style, and size of the text in the plot.
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Hydrograph Window 
 
When you click the "Hydrograph" button, a Hydrograph window appears that requires you to input 
some data.   You need to input the Recurrence Interval and the Lag Time.  This example shows only 
one scenario, Rural 1.  When you click the "Plot" button, you are presented with a Hydrograph Plot 
window displaying a graph of the Peak Discharge (peak flow) vs. Time.
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Hydrograph Window (continued) 
 
The Hydrograph Plot displays the peak discharge in cubic feet per second for a 100-year interval and 
a lag time of 1.25 hours.

 
39



Hydrograph Window (continued) 
 
The File and Edit menus function exactly as those discussed in the Frequency Plot window.  The 
View pull-down menu is unique to the Hydrograph Plot window.
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Hydrograph Window (continued) 
 
The View menu contains a Listing function.  This function opens the Hydrograph Plot List window, 
which lists the data used to generate the hydrograph plot.
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Hydrograph Window (continued) 
 
The Hydrograph Plot List can be edited using the Edit pull-down menu in the Hydrograph Plot List 
window.  This menu includes the General, Fields, Summaries, and Dates functions.
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Hydrograph Window (continued) 
 
The General tab allows you to edit the column title and range of the data.  The Fields tab allows you 
to edit the appearance of the data.  The Summaries and Dates tabs are not used.
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Hydrograph Window (continued) 
 
The Hydrograph Plot List may also be accessed and viewed from the Hydrograph intermediate plot 
window.
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Weight Window 
 
The Weight button in the main window opens the Editing Weight window for generating improved 
results for a gaged or ungaged site.  Gaged sites are based upon regression estimates and the 
observed data.  Ungaged sites are based upon regression estimates and weighted gage values from 
a gaged site on the same stream.
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Weight Window (continued)  
 
You can select which peak flow you wish to weight, enter the number of years of observed data, and 
enter observed data from gaging stations.  This example displays weight data for a gaged site using 
observed data.  When you click the "Apply" button, the weighted peak flows are presented in the main 
window.
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Help Window 
 
The Help menu provides a complete copy of the National Flood Frequency (NFF) program User's 
Manual, a link to the NFF web site, and information about the program's version.  The web site should 
be checked occasionally for updates to the database.
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Program Navigation Summary 
 
Congratulations, you have completed the Program Navigation section of this tutorial.  Here is a review 
of the key points discussed in this section. 
 

The startup window allows you to choose English or Metric units for your section • 
• 

• 

• 

• 

The main window allows you to navigate through the program, input data, select a state and 
hydrologic region, and choose regression equations 
The compute window allows you to input values for variables and to compute peak discharges 
from your input data 
The frequency window allows you to view a computed frequency curve in the form of plots and 
reports 
The hydrograph window allows you to insert a lag time, plot a hydrograph from the estimated 
peak, and save the hydrograph 
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Program Navigation Summary 
 
Key points continued: 
 

The weight window allows you to generate weighted results for a gaged or ungaged site based on 
certain regression estimates, years of data observation, and observed gaged values 

• 

• There are several help functions available both in the National Flood Frequency (NFF) program 
as well as online to assist you in using NFF
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Example Overview 
 
In this section, an example problem will be demonstrated to help you learn the basic functionality of 
the National Flood Frequency(NFF) software.  The example problem includes a small watershed in a 
state with regression equations that include only a few given input parameters.  We will walk through 
the following activities: 
 

Estimating input variables • 
• 
• 

Inputting variables into NFF 
Analyzing results, errors, and output graphics
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Locate the Watershed 
 
A farmer, who lives in the southeastern corner of Minnesota, in Region F, does not want to pay flood 
insurance because he believes his farm is outside the flood hazard area. 
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Locate the Watershed (continued): 
 
Region F equations requires only 2 variables (drainage area and average slope of the main channel) 
to calculate the T-year peak flow, QT.  You need to find these 2 variables before you can input them 
into the National Flood Frequency (NFF) software.
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Locate the Watershed (continued): 
 
First, you need to find the drainage area of the watershed.  Using a topographic map of Region F, you 
delineate the area of the watershed that could directly affect his farm.
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Estimate Drainage Area 
 
Once you have delineated the watershed, use a planimeter to determine the drainage area.  This 
area can be measured in square inches, square feet, or acres and must be converted to square 
miles.
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Estimate Drainage Area (continued) 
 
Alternatively, you may also overlay the watershed with graph paper and count the number of grids 
that approximately cover the watershed.  Convert the grids into area using the scale of the watershed 
map and the grid size.  In this example, the drainage area is estimated at 2.23 mi2.
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Estimate Channel Slope 
 
First, determine the total main channel length of the stream from the point of interest to the furthest 
point on the basin divide that contributes water to the upstream end of the mapped stream using a 
map wheel.
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Estimate Channel Slope (continued) 
 
Next, determine the locations and elevations of points 10% and 85% along the main channel from the 
point of interest.  Finally, calculate the average slope by dividing the difference in elevations by the 
distance in miles between the 10% and 85% points.
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State Regression Equations  
 
The regression equation for Region F is: 
 
Q100 = 94.9 DA0.725SL0.505 

 
You are now ready to input your data into the National Flood Frequency (NFF) software.  Choose 
Minnesota as the state from the State drop-down menu and click the "New" button.
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Enter the data 
 
Select Region F in the Regions window.  Enter your values for the drainage area (2.23 mi2) and main 
channel slope (55.47 ft/mile).  Click the "OK" button to get the results for this example.
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Results 
 
The 100-year peak flow Q100 is 1290 cubic feet per second (cfs) with an average standard error of 
33 percent.  The accuracy of this estimate is equivalent to an estimate from a 26-year gage record.
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Frequency Plot 
 
Here is the frequency plot for Region F in Minnesota.
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Hydrograph Plot 
 
We want to generate a hydrograph from the 100-year peak flow so we can route the hydrograph 
through a detention pond.  We estimate the lag time as 1.25 hours.
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Hydrograph Plot (continued) 
 
The hydrograph plot shows that the period of the entire hydrograph is about 3 hours and that the 
peak occurred at about 1.19 hours.
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Watershed covering two regions 
 
The program can also compute peak flood discharges from a watershed crossing two hydrologic 
regions.  Assume a portion of the farmer's watershed is in hydrologic Region F, and the other portion 
is in hydrologic Region D.  Regression equations from both hydrologic regions must be used in the 
calculation.
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Watershed covering two regions (continued) 
 
Input variables for hydrologic Region F are drainage area (DA) and main channel slope (SL).  Input 
variables for hydrologic Region D are drainage area (DA), main channel slope (SL), and areas of 
lakes (LK).  LK units are expressed in percent of the drainage area.   Measurement and estimation of 
these variables are described in the National Flood Frequency (NFF) manual.
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Results for two regions 
 
The computed 100-year peak discharge is 1,350 cfs with the average standard error of 39%. 
Theaccuracy of the estimate is equivalent to an estimate from a 22-year gage record.
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Weighted discharge:  gaged site 
 
The National Flood Frequency (NFF) software also computes weighted discharges, which is 
particularly useful for large watersheds and estimating peak flows for gages without a long record.  In 
this example, we weight NFF estimates with gage records by entering the length of the gage record 
and gage estimates.
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Weighted discharge:  gaged site (continued) 
 
No regression equation was developed for 500-year flood peak for Minnesota.  The 500-year peak 
flow is extrapolated from fitting a log-Pearson Type III curve to the 2- to 100-year flood peaks given 
by NFF.  Therefore, standard error of prediction and equivalent number of years are not estimated.
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Weighted discharge:  gaged site (continued) 
 
The weighted peak flow estimates are then generated.  Because the 500-year flood peak was 
estimated from extrapolation, it is not used in weighting procedures.  The weighted 500-year peak 
flow is the same as the observed peak flow.
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Weighted discharge:  ungaged site 
 
Estimated peak flows for an ungaged site can be obtained by using the weighted estimate from a 
gaged site.  In this example, we start with our previous scenario "Rural 1 (weighted)".  We compute 
peak flows for an ungaged site on the same stream using regional regression equations.  At this 
location, the drainage area is 125 square miles and the main channel slope is 16.2 ft/mi.  This 
estimate is saved as scenario "Rural 2".
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Weighted discharge:  ungaged site (continued) 
 
In scenario "Rural 2", we click the "Weight" button, click the radio button "Weight for ungaged site 
using weighted gaged values" and select Rural 1 (weighted) from the pull-down menu.  The 
regression estimate of the ungaged site, the weighted estimate for the stream gage site, and the 
weighted estimate for the ungaged site are displayed in the window.  Clicking the "Apply" button 
saves and displays the results of Rural 2 (weighted).
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Weighted discharge:  ungaged site (continued) 
 
A composite report of all the Minnesota scenarios is available in the File menu.  You are prompted to 
name and save the report to a directory, which in turn launches a text editor (e.g., Notepad) that 
displays the report.
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Example Summary 
 
Congratulations, you have completed the Example section of this tutorial.  Here is a review of the key 
points discussed in this section. 
 

There are several input parameters for the National Flood Frequency (NFF) software that must be 
estimated or researched such as: 
- Rainfall (RF) 
- Drainage area (A) 
- Channel slope (SL) 

• 

• 
• 
• 

After collecting all input data, enter the data into NFF and compute it. 
Analyze the results of the data calculations by viewing the various reports. 
Use sensitivity analysis to learn more about input factors and to produce a more accurate result. 
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